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Getting Started for Analysts

TIBCO Business Studio - Analyst Edition is a simplified version of TIBCO Business Studio useful for
business analysts or those responsible for high level or abstract modeling. The ribbon-based toolbar
provides a familiar, easy to use interface and allows the user to access all the artifacts from a single file.

● See How to Model a Simple Business Process in TIBCO Business Studio - Analyst Edition for a simple
tutorial on using TIBCO Business Studio - Analyst Edition.

● TIBCO Business Studio - Analyst Edition allows the business analyst to use forms functionality to
design and preview forms. See the TIBCO Business Studio Forms User Guide for more information.

● TIBCO Business Studio - Analyst Edition allows business analysts to simulate processes and compare
simulations. See How to Simulate a Simple Business Process in TIBCO Business Studio - Analyst Edition
and the TIBCO Business Studio Simulation Guide for more information.

Modelled Application Archive
To enable the Business Analyst to access all the artifacts of a BPM project from a single location, TIBCO
Business Studio saves the project as a Modelled Application Archive (MAA) file with a .maa file extension.

The MAA file contains information about the BPM project and its artifacts such as the organizational
model, business object model, business processes, and packages.

The following figure describes the lifecycle of a typical MAA file.

1. The Business Analyst models the process in TIBCO Business Studio - Analyst Edition, and saves the
project as an MAA file.

2. The Solution Designer imports the MAA into TIBCO Business Studio using the Import > Existing MAA
Files into Workspace wizard.

3. If the model needs to be modified, the Solution Designer exports the updated MAA from the existing
project and passes it to the Business Analyst. The Business Analyst makes the changes to the model and
passes the updated MAA back to the Solution Designer. The Solution Designer then re-imports the
MAA into TIBCO Business Studio.
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Creating an MAA
To create a Modelled Application Archive (MAA), do one of the following:

● When you first launch TIBCO Business Studio - Analyst Edition, a dialog offering a number of options is
displayed. Click the Create new project link and enter the name of the new project in the New Project
dialog.

● Select the New... icon  from the ribbon, click the Create new project link and enter the name of the
new project in the New Project dialog.

The derived artifacts such as generated WSDLs, business objects, forms, etc are not included in
the generated MAA file and may need to be regenerated when you import the generated MAA
file to a different workspace.

In all the above cases, the project is saved as an MAA file.

Accessing an MAA
To access the .maa file, do one of the following:

● Double-click the MAA file to open the project in TIBCO Business Studio - Analyst Edition.

● Click the Open icon  on the ribbon to look for an existing MAA file.

● Select the New... icon  from the ribbon, click the Open an existing MAA link and browse to the
MAA you want to open.

You can create an MAA file in TIBCO Business Studio - Analyst Edition, save it and then
import it as an existing MAA into TIBCO Business Studio. You can then work on the projects it
contains and save it, and export it to MAA, and then access it again from TIBCO Business
Studio - Analyst Edition. You will not lose any data when you do this.

Alternatively, you can commit the projects into SVN, check them out in TIBCO Business
Studio, work on the projects and re-commit into SVN and then update or check them out in
TIBCO Business Studio - Analyst Edition.

TIBCO Business Studio - Analyst Edition Ribbon-Format Controls
TIBCO Business Studio - Analyst Edition provides controls in the ribbon format. Also, the related
commands are organized into groups which are provided in the horizontal bar at the top of the application
window.

Following are the controls available at the top left-hand end of the ribbon.
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Control Description

The dropdown gives the following choices, most of which are described elsewhere in
this document:

● Save As gives you the choice of saving the project/s to MAA... or to an External
Folder.

— If you are editing an MAA then you have the option to Save As another MAA
(make a copy of the current MAA) or Save As External Folder (copy the projects
out to the given folder location).

— If you are editing projects from a folder location then you can only Save As
MAA (create an MAA file for the projects).

Note: Save As will save all the projects to the chosen target (whether it is an MAA or
folder) but you will continue to work on the current projects (and will not switch to the
Save As location).

New Create a new MAA or open existing projects.

When you click  , the dialog appears with the following options:

● Create new project

The New Project dialog allows you to name the project, and add whichever of the
following assets you want to add to the project: Business Process, Business Object
Model, Organization Model.

● Open an existing MAA

You can open an existing MAA from the location of the last MAA you used, or
browse to a location containing the MAA you want to use.

● Open projects from a folder location

Browse to a location to open an existing BPM project which has been created using
TIBCO Business Studio.

Note: TIBCO Business Studio - Analyst Edition import is only supported for BPM
projects (any other TIBCO Business Studio artefact can be imported, but will be an
empty container and cannot be used).

● Open projects from a SVN URL

The Checkout from SVN dialog allows you to check out projects from an SVN
repository.

Open File Opens an existing MAA or model.

When you click  , the Select File to Open dialog appears. You can do one of the
following:

● Select a .maa file - opens the MAA with the Overview tab as the active tab.

● Identify another type of file to open using the dropdown Files of type... (*.bom,
*.om, *.xpdl).Navigate to an individual model (or process package) and select it.
This opens the selected model in the edit mode.
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Control Description

Save Saves the BPM projects as an MAA file.

When you save a new project for the first time, the Save New Project dialog allows you
to choose the location of the MAA file. Subsequent changes to the project are saved to
the file at the same location.

The Home menu provides access to the following groups:

Control Description

Diagram The controls in this group affect the selected model or package.

Edit The controls in this group affect the selected object.

Models The Models group consists of controls to create or edit Process Packages, Business
Object Models, and Organizational Model.

See the section about projects, packages, and processes in the TIBCO Business Studio
Modeling Guide for more information.

Process
Simulation

The Process Simulation group consists of controls to simulate processes.

The TIBCO Business Studio Simulation User’s Guide describes using simulation in
detail.

Zoom The controls in this group allow you to change the zoom level of the diagrams.

The following table describes the controls available within the group Diagram.

Control Description

Overview Shows the Overview view of the BPM projects.

Rename Renames the selected project, model or package.

The Rename dialog allows you to enter the new name for the selected project,
model or package.

Duplicate Creates a copy of the selected model or package and appends the text Copy_ Of_
to the original name.
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Control Description

Import This is a drop-down button with two options:

● Import Nimbus Process Diagram... Launches the Nimbus Import wizard as
described in the section about importing and exporting projects in the TIBCO
Business Studio Modeling Guide. The wizard will ask you to select the target
project into which you want to to import the model. The choice of projects will
be limited to projects with the "Business Process" asset configured.

To be imported into TIBCO Business Studio, Nimbus Process Diagrams must be
exported from the Nimbus Control application using the Simplified XML
export format. See the TIBCO Nimbus Control documentation for more details.

● Others... Launches an existing TIBCO Business Studio - Analyst Edition export
(you select the file to import).

Publish Generates the documentation for all the assets in the BPM projects and saves it in
the selected destination folder. If the Open the documentation on completion
checkbox is selected, the generated documentation is opened in the default
browser.

Print Prints the selected model.

To delete, select what you want to delete, and then click Delete in the Edit group.

The following table describes the controls available within the group Process Simulation.

Control Description

Enable Opens the process in simulation mode. This will identify any problems in the
process with problem markers. You should fix these problems before you attempt a
simulation.

Prepare Prepares the process for simulation. You will be warned if there are errors in the
process which will prevent simulation.

Run Runs the simulation.

Compare Compares the results of different simulations of the process.

The Help menu provides access to the following:

Control Description

Help Contents Opens the TIBCO Business Studio Help system.

About Opens the About dialog which provides information about the TIBCO Business
Studio version, features and plug-ins, and configuration details.

Configuration
Details

Opens a dialog to provide the configuration details. You can also access the
configuration details from Help > About > Configuration Details .
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Control Description

Preferences Opens the Preferences page which captures the user information and preferred
settings for the project.
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How to Model a Simple Business Process in TIBCO
Business Studio - Analyst Edition

TIBCO Business Studio - Analyst Edition is the version of TIBCO Business Studio that enables a business
analyst to model a business process, design and preview forms, simulate the process, and store all the
artifacts of the process in a single file. Its straightforward interface is suited to users doing high level or
abstract modeling.

This tutorial shows you how to use TIBCO Business Studio - Analyst Edition to rapidly model a simple
Motor Claims business process that represents part of the business of an insurance company. In this
process:

● A motor insurance claim is assessed, as to whether it involves a fault or is a no-fault claim.

● Depending on the result of that assessment, processing passes to either one of two user tasks, one for
fault and one for no-fault claims.

● Each task references the data fields defined for the corresponding business objects.

● The participants responsible for carrying out the user tasks are mapped to positions in a corresponding
organization model.

You should work through each section in turn to complete the tutorial.

Key Points

Although it uses a very simple example, this tutorial demonstrates some of the fundamental points of the
analysis phase for any business service:

● creating and assigning the business data required by the process

● designing the process flow

● creating and assigning the participants who will be involved in the process

● placing and describing tasks such as scripts (or services) that will be implemented later by the solution
designer.

● saving the project as an archive file which you can pass on to a solution designer, who uses TIBCO
Business Studio for the next stages of the development process

Creating a New Project
A project is the basic container that you use to store all the artifacts needed by your business process. The
project you create here contains a basic organization model and a basic business object model. TIBCO
Business Studio - Analyst Edition saves a project as a Modeled Application Archive file with the
extension .maa, which you can pass on to the solution designer for the next stages of the design process.

Procedure

1. Start TIBCO Business Studio - Analyst Edition (for more information, see the installation guide.

Click , either on the dialog that displays when TIBCO Business Studio - Analyst Edition opens, or on
the ribbon at the top of the screen.

2. The New Project dialog displays. Enter MotorClaims as the Project name and accept the default
selection of the assets to add to the project (Business Process, Business Object Model and Organization
Model).

3. Click Finish. The MotorClaims project is created. It is shown in the left column, with Processes,
Business Object Models and Organization Models in the right column.
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The new project contains the following artifacts:

● An organization model, containing a single organization called Organization1
● A business object model, called MotorClaims.bom.
● A process package, containing a single process called MotorClaims-Process.

Each of these three artifacts is displayed on its own tab.

A fourth tab contains an overview of the project, as shown in the illustration above. The Overview
page shows any error icons next to the relevant artifact, and the details of the error are shown in
the Problems view.

If you close any of the other tabs, you can re-open it by clicking Overview in the Diagram group,
from the Overview tab, or from the tools on the Models group of the ribbon.

Click once on each of the artifacts to display its properties in the Properties view. Double-
click to open the editor for that artifact.

Click on the icon by an artifact to go to the wizard to create a new version of that artifact.

4. Click the MotorClaimsProcess process package tab. The Process Editor is displayed.

5. On the Properties tab for the business process, select the Label field. Change the label to MotorClaims.
Click away from the field to save the label change.

6. Click the Organization1 tab.

7. On the badge that shows the name of Organization1, click on the name and use Rename from the
ribbon to rename it. Type EasyAs and click away from the field or press Enter to save your name
change.

Click  or press Ctrl+S to save the changes you have made to the project.

8. You are prompted to select a location to save the file. Select a suitable folder and save the file as the
default MotorClaims.maa. This is the archive file which, when the analysis phase of the project is
complete, you would pass on to the solution designer.

Result

Next you should complete Defining Business Data

Defining Business Data
The business object model created in the project holds the business data, representations of business objects
and the relations between them. The business process that you will define in later procedures uses this
business data.

The simple business object model in this tutorial contains objects relating to a motor insurance claim:

● A class representing the claim itself
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● Classes representing the two types of claim, fault and no-fault, which are subordinated to the claim
class

● Connections between these objects

Classes can be embedded in a higher-level object, a package. The business object model itself is
a package; intermediate packages are not necessary in simple models such as this example.

Procedure

1. To rename the model, click the .bom tab. The business object model editor opens.

2. In the Properties view for the model, select the text in the Label field. Type Motor Claims business
objects.

3. Click away from the field to save your change.

4. To create the classes, select the Class tool in the palette. Drag it on to the empty canvas of the editor and
drop it. This places a class in the diagram.

5. The label field of the new class is automatically selected at this point. Type Generic Claim into the
selected field. Click away from the field to save the label.

6. Create two more classes in the same diagram. Call them Fault claim and No fault claim.

Click  or press Ctrl+S to save the changes you have made to the project.

You can also save your process at any point while you are creating or editing it. If there are
unsaved changes, an asterisk is displayed in the title of the editor tab.

It is advisable to save after completing each procedure.

7. A class can contain attributes. Each attribute represents an individual piece of information. In this
tutorial you will add a few attributes to the classes; a realistic model would have a great many more. To
add attributes to the classes, in the palette, select the Attribute tool. Drag it over the Generic Claim class
in the diagram and drop it.

8. Select the attribute, and on the General tab of the Properties view, type Claim Description in the Label
field.

9. Add a second attribute to the same class and call it Claim Amount.
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Attributes default to a type of Text, as shown in the previous illustration. This is appropriate for the

claim description, but not for the amount. Click the browse button . The Select Type browser is
displayed.

10. Click Integer - Bom Primitive Types and click OK.

11. Add an attribute called Counterparty to the Fault claim class, and an attribute called Confirmation of
no fault to the No fault claim class. Keep the default Text type for both these.

12. To add relationships between classes, from the Relationships tool group on the palette, select the
Generalization tool.

Relationships indicate connections between objects in a business object model. Connections can be
generalizations or compositions.

A generalization connects two classes, and it indicates that one of the two classes is a more general form
of the other. Another way of describing it is that the more specialized class is a derived version of the
more general class. In this procedure the Fault claim and No fault claim classes represent specific types
of claim, and so are derived from the general Generic claim class. Both inherit the properties of Generic
Claim, including the Claim description and Claim amount attributes. The additional attributes that
Fault claim and No fault claim possess apply only to that one class each.

13. Click on the No fault claim class and drag the pointer to the Generic Claim class. This creates the
generalization. Note that the General tab in the Properties view for the generalization indicates the
classes that it links.

14. Link the Fault claim class to the Generic Claim class with a generalization in the same way.

Result

Click  or press Ctrl+S to save the changes you have made to the project.

Next you should complete Outlining the Business Process
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Outlining the Business Process
The Process Editor is where you create your business process. It includes a palette that contains the tools
you use to create your process.

A default process is automatically displayed in the Process Editor when you create the project that contains
it. The MotorClaims process is empty. It contains only a Start event, an End event, and a sequence flow
between them.

You will now add the basic elements of the process:

● the Tasks that make up the process

● Gateways, where the flow of processing branches according to decisions taken

● and modify sequence flow, which shows the flow of activities through the process, to fit with the tasks
and gateways.

Procedure

1. Click the Show Palette arrow at the top right-hand corner of the Process Editor to display the palette:

The palette contains a number of drawers, each of which contains a set of tools.

2. Click the Tasks drawer in the palette to open it.

Click the User Task tool .

3. Position the mouse pointer after the start event. The guide line displays again.
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Click to add the user task.

4. Change the user task label to Specify Claim Type and click away from the field to save the change.

5. On the canvas of the Process Editor, between the existing task and the End event, add two more User
Tasks. Place one above the other, and call them Record fault claim details and Record no-fault claim
details. Your process should now look like this.

6. Next, you will indicate the way that these tasks are connected. The result of the Specify claim type task
is a decision whether the claim is a fault or a no-fault claim. If it is a fault claim, the Record fault claim
details task is executed; otherwise, the Record no-fault claim details task is executed.

You use a gateway to indicate this branching in the processing flow. Open the Gateways drawer in the

palette and click on .

7. Position the pointer on the sequence flow to the right of the Specify Claim Type task and click to place
the gateway. Call the gateway Fault claim?.

8. Add another gateway to the left of the End event. Call the gateway End claim.
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9. To delete the section of the process flow that runs between the two gateways, right-click on it and select
Delete from the popup menu.

The flow of processing branches after the Fault claim? gateway, and one of the two paths must be
designated as the default. Open the Connections drawer in the palette and click on the Default Flow

tool .

10. Move your pointer to the Fault claim? gateway, click on it, drag the pointer over to the Record no-fault
claim details task, and release it.

11. Type No in the Label field on the Properties tab, to identify the connection.

In the palette, click on the Conditional Flow tool .

12. Draw a connection from the Fault claim? gateway to the Record fault claim details task, and type Yes
in the Label field on the Properties tab.

Result

Draw unconditional connections, using the Sequence Flow tool,  from the two user tasks to the second
gateway (End claim). Your process should now look like the following illustration.

Click  or press Ctrl+S to save the changes you have made to the project.
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You have now completed the outline of the process.

Next you should complete Creating a Conditional Script

Creating a Conditional Script
The flow of processing branches at the Fault claim? gateway depending on whether a fault claim or a no-
fault claim is being made. You will create a data field IsFault which, if set to True (meaning that the claim is
a fault claim), directs the flow down the conditional flow connection to the Record fault claim details task.

If the field is set to False (meaning that the claim is not a fault claim), processing follows the default flow
connection to the Record no-fault claim details task.

Procedure

1. Click on the Specify Claim Type task. The Properties tab at the base of the window displays the
properties for that task.

2. In the Properties tab, click on Data Fields.

3. Click the plus sign at the right of the Data Fields tab.

4. Click in the Label column and change the label from the default Field to IsFault.

5. Click in the Type column and select Boolean from the drop-down list.

6. To attach a script to the conditional flow:In the Process Editor, select the conditional flow object (the
connection that runs to the Record fault claim details task).

7. In the General tab of the Properties view, select Free Text instead of the default Undefined from the
Script Defined As drop-down list.

8. In the Describe Sequence Flow Condition field, type:
IsFault = True

Because this is free text, which a solution designer would interpret as the analyst’s
requirement for implementing a script, the exact format does not matter. The designer can
then implement the script using JavaScript or some other syntax that is appropriate to the
environment on which the process will be executed.
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Result

Next you should complete Adding Data to the Process

Adding Data to the Process
Data is input to a process using parameters. Data fields can be assigned to user tasks to obtain and display
information. In the runtime version of a business process, the data fields associated with a user task would
be reflected in the forms produced for that task. Data fields can also be manipulated in script tasks.

To add the data to the process, you must first define the required fields, then assign them to the user tasks.

Procedure

1. Click on the background of the Process Editor. The Properties tab at the base of the window displays
the properties for the MotorClaims business process itself, rather than the properties for any element
within it.

2. In the Properties tab, click on Data Fields.

3. Click the plus sign at the right of the Data Fields tab. A new field displays.

4. Click in the Label column and change the label from the default Field to Generic claim data.

5. Change the Type to External Reference. This allows you to map the field to an object defined outside
the process, in this case to a class in the business object model.

Select the External Reference field. Because you specified External Reference in the Type field, a

browse button  becomes available. Click it.

6. The Select Type dialog is displayed. Type g in the Select type box to narrow your search.

7. Select the Generic Claim class and click OK.

8. Similarly, add the following fields:

● Fault claim data, mapped to the Fault claim class

● No-fault claim data, mapped to the No fault claim class

Click  or press Ctrl+S to save the changes you have made to the project.
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9. In the Properties view for the Record fault claim details user task, click on Interface.

Click the plus sign  at the right of the Interface tab. The Select Data Field or Formal Parameter
dialog displays.

10. Select Fault claim data and press Add.

11. Then select Generic claim data and press Add (alternatively you can multi-select and add both Fault
claim data and Generic claim data at the same time).

12. Press OK. This gives the Record fault claim details user task access to the data fields included in both
the Generic claim and the Fault claim business objects; that is, to all the data about a fault claim.

13. Similarly, for the Record no-fault claim details user task, add the same Generic claim data field, and
also add the No-fault claim data field.
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Result

Click  or press Ctrl+S to save the changes you have made to the project.

Next you should complete Defining an Organization Model for the Process

Defining an Organization Model for the Process
An organization model captures and defines information about how an enterprise is organized. The model
represents the different entities in the organization (such as positions, organization units or groups), their
organizational structure and the relationships between them.

The model can also describe characteristics that can be possessed by those entities—such as privileges,
capabilities or location—but this simple tutorial does not include any of these characteristics.

A process designer can use the information defined by the organization model to ensure that the process
sends the right work to the right people at the right time.

Only entities defined in the organization model can be assigned (as participants) to perform user tasks in
processes. See Adding a Position as a Participant to the Process.

An organization model does not define the actual users (resources) who belong to it. Assigning users to
organization model entities is a separate task, performed at runtime using the Organization Browser in
TIBCO Openspace or in TIBCO Workspace.

Procedure

1. Click the EasyAs organization tab. The Organization Editor opens. You use the Organization Editor to
produce an organization diagram, showing the structure of an organization, the organization units and
positions it contains, and the relationships between them. The Organization Editor:

● contains a canvas area and a palette. The palette contains a different set of tools than those
provided in the Process Editor or Business Object Model Editor.

● initially shows an empty organization, which you have already renamed EasyAs.

Click the Organization Unit tool  in the palette.

2. Position the mouse pointer anywhere in the Organization Editor canvas, then click to add an
organization unit to the organization. Or select the Organization Unit from the palette and drag and
drop it.

3. Change the organization unit label from OrgUnit1 to Claims Department. (Click away from the field in
the Organization Editor or press Enter to save your label change.)

4. Click the Hierarchy tool in the palette. Click on Claims Department, hold the mouse button down, and
drag the pointer downwards a short distance. When you release the button, the label Create
OrgUnitRelationship to New Element: OrgUnit displays.
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5. Click on that label and a new organization unit is added. It is linked by a Hierarchy link to Claims
Department, indicating that the new unit is subordinate to Claims Department.

6. Change the label of the new unit to Motor claims unit.

Drag and drop Position from the palette into the Motor claims unit. A position called Position1 is
created within the unit.

7. Click Position1 to allow you to change the label for it to Manager. Click away from the field in the
Organization Editor to save your label change.

Drag and drop Position  into the Motor claims unit a second time.

8. Change the new position’s label to Customer service rep.

9. Change the Number field on the General tab for Customer service rep to 6. This indicates the ideal
number of these positions in the unit.

Result

Click  or press Ctrl+S to save your changes to the organization model.

Next you should complete Adding a Position as a Participant to the Process
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Adding a Position as a Participant to the Process
Participants represent the users who perform the work defined in user tasks.

Note that:

● Participants must be defined as external references to the organization model used by the process.

● Every user task in a process must have a valid participant.

You must first define the participant. Then you assign the participant to each user task that you want that
participant to receive work items from.

Procedure

1. In the Process Editor for the MotorClaims process, display the Properties view for the business process.
Click on the Participants tab.

Click the plus sign  at the right of the Participants tab. A participant displays.

2. Change the Label to Claims checker.

3. Change the Type to External Reference. This allows you to select a participant from an organization
model defined outside the process.

Select the External Reference field. Because you specified External Reference in the Type field, a

browse button  becomes available. Click it.

4. The Select Type dialog is displayed.
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5. Select Customer service rep , then click OK.

Type the first letters of ’Customer ...’ in the box entitled Select type(s) (? = any character, * =
any string): to show all external references starting with those letters.

6. Define another participant called Claims manager and link them to the External Reference Manager.

Click  or press Ctrl+S to save the changes you have made.

7. Right-click on the Specify Claim Type task and select Participant... from the pop-up menu.

8. The Select Participants dialog displays.
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Claims checker is already highlighted, so click on Add and then OK.

9. Hover your mouse pointer over the Specify claim type task, and note that the information displayed
now includes the identity of the participant associated with this task.

10. Add the same participant to the Record no-fault claim details user task.

11. Add the Claims manager participant to the Record fault claim details user task.

Click  or press Ctrl+S to save the changes you have made.

Viewing and Testing Forms on User Tasks
The form-modeling features of TIBCO Business Studio - Analyst Edition enable you to design, view, and
test the forms you need to collect user input from user tasks.

TIBCO Business Studio - Analyst Edition automatically generates a default form for each user task in a
business process. Users can also open the form for editing and customizing manually. See the TIBCO
Business Studio Forms User Guide for more information.

Procedure

1. Select the Specify Claim Type task.

2. From the General tab, select the Form... radio button. The following warning appears.
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3. Press OK, and the following information is shown.

4. Select Open Form. A form is shown in the design tab. The screenshot shows the start of this long form.
You can only view and not edit in the Design tab:

5. To preview the form and test its functionality, select the the GWT Preview tab. You will see a preview of
the form and can enter information in the available fields.
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6. Try entering some changes to the number in one of the the Claim Amount fields on the form and then
press Submit.

7. The lower panel (gwt-log) shows a log of the processing of the form, similar to the following.

Result

Refer to the TIBCO Business Studio Forms User’s Guide for more information.
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How to Simulate a Simple Business Process in TIBCO
Business Studio - Analyst Edition

Using TIBCO Business Studio - Analyst Edition you can simulate a process to give you a quick idea of how
efficient it is before you decide to send it to the solution designer to implement. When you simulate a
process, you can identify any problems with it, such as bottlenecks and areas of high cost or reduced service
levels. You can then make changes to minimize these problems , then simulate the process again and
compare the results.

Although it uses a very simple example, this tutorial demonstrates some of the fundamental points of
simulating a business process, making a change in the process, and then simulating it again and comparing
the results.

To learn more about simulation refer to the TIBCO Business Studio Simulation Guide.

Next complete Creating a New Business Process

Creating a New Business Process
You can create a simple business process and use simulation.

Procedure

1. Using the skills you learnt in How to Simulate a Simple Business Process in TIBCO Business Studio -
Analyst Edition create the following simple process.

2. Add participants called ’Claims Administrator’ and ’Claims Manager’ at the process level, and make
them of type Role.

3. Assign the participant ’Claims Administrator’ to all tasks except Payment for Pet Claim. Make the
Participant for that task ’Claims Manager’’. To do this, right-click on the task, select Participant... and
use the Select Participants wizard.

Result

Next you should complete Simulating your Project

Simulating your Project
You can simulate the project you have just created. This will allow you to see how efficient it is, and what
resources it uses.

When you have simulated it, you can make a change to it and simulate it again. You will then be able to
compare the results of the two simulations. See Comparing Simulations.
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Procedure

1. Select Enable from the Process Simulation group.

2. Your business process will now have any problems or warnings identified. You can ignore warnings,
but you must fix any problems identified, or your simulation may not run. You can use the quickfix
available to add simulation data to different tasks in your process.

3. Select Prepare from the Process Simulation group. This sets up parameters necessary for simulation to
run. It can also fix some problems which do not have a quick-fix available.

4. Select Run from the Process Simulation group. This will run the simulation.

By default a simulation runs with a Simulation Start Date/Time that is the current system date/time, but
you can set the desired Simulation Start Date/Time using the drop-down calendar and by entering a
time value.

The simulation runs:

● The Simulation Control View shows simulation time and the progress of simulation.

● The Simulation Results View displays the number of cases and updated simulation data about the
Activities and Participants such as the Cost.

● The number of queued and processed cases is indicated on the Process .
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5. Now make a change to the process. Delete the gateways and the user task Rejection Letter for Pet
Claim, so you have a business process which looks like this:

6. Run the simulation again.

Result

Next you should complete Comparing Simulations
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Comparing Simulations
You can compare the results of the simulations of the project you have just created. This will allow you to
analyse the effect of the change you made to the process.

Procedure

1. Select Compare from the Process Simulation group.

2. Select the simulations you want to compare from the list available (in this case, the one you did of the
full process, and the one you did after removing the gateways, connection and user task).

3. Select the type of report you wish to run from the options on the right-hand side. In this case select Case
Cost-Time Analysis.

4. You will then be able to select from Display Report, Save HTML Report and Save PDF Report. In this
case select Display Report.

5. You will see a report which starts with the information in the screenshot below. For further information
on interpreting Simulation reports refer to the TIBCO Business Studio Simulation Guide.

Result
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.
The website is updated frequently and is more current than any other documentation included with the
product.

Product-Specific Documentation

The following documentation for TIBCO Business Studio is available on the TIBCO Business Studio
Product Documentation page:

● TIBCO Business Studio™ Release Notes

● TIBCO Business Studio™ Concepts

● TIBCO Business Studio™ Modeling User's Guide

● TIBCO Business Studio™ - Analyst Edition User's Guide

● TIBCO Business Studio™ - BPM Implementation

● TIBCO Business Studio™ Forms User's Guide

● TIBCO Business Studio™ Simulation User's Guide

● TIBCO Business Studio™ Customization

● TIBCO Business Studio™ - Analyst Edition Installation

● TIBCO Business Studio™ - BPM Edition Installation

● TIBCO Business Studio™ iProcess to BPM Conversion

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, Enterprise Message Service, Business Studio, and ActiveMatrix
are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms
for a specific software version are released at the same time. See the readme.txt file for the availability of
this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED
IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2004-2022. TIBCO Software Inc. All Rights Reserved.
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